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Chapter 1:  Introduction 
This manual is for the Diagnostic software of the REG Dream XXI-P automotive gas injection 
electronic control unit (ECU). 

 

 
REG Dream XXI-P  injection ECU 

 

1.1  Software installation 
Please insert the software installation CD-ROM: your PC should detect it and start the automatic 
installation procedure. If the installation procedure doesn’t show up, you can start it manually: 
browse the CD-ROM contents and double clicking on the Setup.exe icon. 
The software is compatible with Windows Vista, XP, 2000, ME and 98. 
Once the automatic procedure starts, a welcome window shows up: please click on the Next button. 
The software version is reported here for your convenience. 
 

 
Welcome window 

 

1.1.1  Serial number 
The next window requires you to enter you full name and company. 
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Type-in user information 

 
IMPORTANT: please take a moment to type-in the 8-digits serial number of the software. If your 
dealer supplied you a serial number, this is the time to enter it; if you don’t have a serial number, 
please type BASE-LVL1. 
The serial number enables your password for higher access level, so please type it carefully. 
 

1.1.2  Completing installation 
The installation is completed in the next window, showing a progress bar while it copies the files to 
your hard-drive; it should complete in few seconds. The software will be installed into the 
C:\Program Files\OMVL\Dream XXI-P Diagnostic folder.  

 

 
Installation in progress 

 

A Dream XXI-P Diagnostic folder is created in the Start menu of your PC, with the short-cuts 
for the software; an icon short-cut is placed on your desktop, too. 
Windows 2000, XP, Vista: the procedure automatically installs the drivers for the REG USB 
interface, at the end of software installation. 
Windows 98 or ME: you need to install the REG USB interface drivers manually. 
When the installation is complete, click on the Finish button. 
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Installation complete 

 
You can now start the software double-clicking on its icon on your desktop, or selecting its short-
cut in the Start menu. 

 
 

1.1.3  Higher access level 
The software has got two access levels: Base access level and Higher access level. The first has a 
simplified user interface, while the latter lets you access more parameters; the parameters not 
available in Base level are set to default values, so they need no change. 
After installation, you are logged into base level: if your dealer gave you a password for higher 
level (along with the serial number) now it’s the time to activate it. 
 

 
File menu 

 
Start the program and select the File menu of the menu-bar at the top-left of the main window: 
there’s no need to connect an ECU at this time. Select now the Access level item in the File menu: it 
pops-up a dialog where you can type the password. 
The password is made up of 16 digits, grouped 4 by 4; once typed completely, press the ENTER key 
on your keyboard or click on the Ok button. 
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Higher access level dialog 

 
If the password is correct, you are immediately logged into higher access level: you can see it in the 
at the bottom of the dialog, where now you should read Access level: 2. You can close the 
dialog. 
The password is stored automatically, so you don’t need to type it again: from now on, you will be 
logged into higher access level. If you need to take a look at the Base level, you can click on the 
arrow on the bottom of the dialog: you will temporarily get into lower level. Close the software and 
open it up again, to get back to higher level. 
Trouble shooting: if you mistyped the password, the dialog warns you of the wrong password and 
you can type it again. 
If you typed the correct password but the program still rejects it, you have a wrong serial number: 
open the Help menu and select the About item. A window will show your serial number (S/N): 
check it against the one supplied by your dealer. 
If the serial number is wrong, you need to install the software again, typing the right one in. 
 

1.2  PC connection interface 
The ECU wiring harness has got a yellow 4 pin socket for PC connection: you need a REG USB 
interface, p/n 410665. Remove the black rubber cap from the socket and plug in the interface. 
 

 
REG USB interface 

 
Locate a free USB socket on your PC and plug in the USB interface: with Windows 2000, XP or 
Vista, its drivers are automatically installed during software installation, so you can use the software 
immediately. 
With Windows 98 or ME, you need to install the USB drivers, before you can use the software. 
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1.2.1  Windows 98: USB drivers installation 
If you are using Windows 2000, XP or Vista, you can ignore this paragraph. 
Please be sure that the CD-ROM of the software installation is in your CD drive. Connect the 
device to a spare USB port on your PC: this will launch the Windows Add New Hardware Wizard. 
Click Next to proceed with the installation. 
Note: on some Win98 releases the Wizard doesn’t come up. hut down and restart your PC with the 
USB interface connected: the new hardware Wizard should come up during system start. 
 

 
Add New Hardware Wizard 

 
Select Search for the best driver for your device. (Recommended), as shown below and 
then click Next. 
 

 
Search for the best driver 

 
Select Specify a location and uncheck all others boxes. Click Browse and locate the driver files: 
the USB drivers are inside the CD-ROM, in the Win98 USB Interface Drivers folder. Click 
Next to proceed with the installation. 
 

 
Specify a location 

 
Once Windows has found the required files, click Next to install the device. 
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Ready to install 

 
Windows then displays a message indicating that the installation of the USB serial converter was 
successful. Click Finish. 

 
USB drivers installation complete 

 
If you want to check the installation and the COM port number of the REG USB interface, open the 
Device Manager (located in Control Panel\System, then select the Device Manger tab). The device 
appears as an additional COM port labeled USB Serial Port. 
 

 
Windows 98 Device Manager 

 

1.2.2  Windows 98: COM port setting 
If you are using Windows 2000, XP or Vista, you can ignore this paragraph. 
With Windows 98 and ME, the software is not able to find the USB interface automatically: it 
accesses the USB interface thru a COM port, so you have to manually select the right COM port 
number. 
Disconnect the USB interface (if connected), wait few seconds and open the ECU menu: this menu 
lists all the COM ports installed on your PC (including modems). Please take note of all the COM 
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ports listed here. 

 
COM port selection in ECU menu 

 
Close now the ECU menu and connect the USB interface; wait few seconds and open the menu 
again. This time there will be one more COM port, so check the old COM port listing and select the 
new COM port. The setting is automatically stored, so the next time you’ll run the program it will 
be recalled. 
 

1.2.3  Establishing a communication 
In order to start the communication with the ECU, you need: 

• The software running 

• The key of the car must be in the On position (no need to run the engine) 

• USB interface must be connected 

• Windows 2000, XP or Vista: the communication starts automatically 

• Windows 98 and ME: USB drivers must be properly installed and COM port setting 
correctly set. Then the communication will start. 
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Chapter 2:  Main window 
When you start the program, a splash window welcomes you and then the main window shows up. 
  

 
Main window 

 
Once running, the program tries to start the communication with the ECU; when it finds it, the 
configuration stored in it is automatically uploaded in few seconds and displayed on screen. A big 
green box pops-up at the bottom of the window, showing the upload progress.  
 
Watching at the main window from top to bottom, you find: 

• Title bar: it shows the program version and the current configuration file 

• Menu bar: with File, Edit, ECU, Diagnostics and Help menus 

• Tool bar: with the Load, Save, Undo and Display buttons. When working with 2 banks, 
a Bank button will be visible, too. 

• Parameter pages: with General, Functions, Gas map, Corrections (only for level 2), 
Emulation (level 2) and Drivability pages. To view a page, click on the label on the top of 
it; you can see only one page at a time. 

• Status panel: showing the working point of the engine and the lambda signal diagram 

• Status bar: it shows the ECU firmware version. If the program doesn’t find an ECU, it 
displays ‘ECU not connected‘. 

 

2.1  Menus 
There are 5 menus for the main operations of the program: File, Edit, ECU, Diagnostics and Help. 
 

2.1.1  File menu 
Open: pops-up a file-open dialog that lets you load a configuration file (.cfg). It’s equivalent to the 
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Open button on the tool-bar. The file name of the opened configuration is shown on the title bar. 
Note: each time you open a configuration, it’s automatically downloaded it into the ECU. If the 
previous configuration is not saved, the program asks you to save it before opening the new one. 
 

 
File menu 

 
Save: pops-up a file-save dialog that lets you store on your hard-drive the current configuration. It's 
equivalent to the Save button on the tool-bar. The program will suggest a default name for the file. 
Note: whenever the ECU is connected, any parameter change is immediately downloaded to the 
ECU, so the current configuration is always stored inside the ECU. 
Language: shows the supported languages. The software will immediately translate into the chosen 
language. 
Access level: this item is discussed in the Higher access level Paragraph of the first Chapter, and lets 
you type-in the password for Higher access level. 
Exit: closes the program. If the current configuration is unsaved, it asks you to save it. 
 

2.1.2  Edit menu 
Wizard: it starts a guided procedure that helps you tuning up the ECU to run on gas. It’s the same as 
the Wizard button on the first page. Refer to the Wizard chapter for details. 
Note: whenever the program finds a brand new ECU, it starts the Wizard automatically. 
 

 
Edit menu 

 
Copy: copies data from a map to a clipboard. Used with Paste command, lets you move data from 
one map to another. Please refer to the Maps and Tables chapter for details. 
Paste: copies data from the clipboard to a map. Refer to the Maps and Tables chapter. 
Undo: cancels the last operation you have done. It’s exactly the same as the Undo button in the tool 
bar. Please note that there is only one level of undo: only the last operation can be cancelled. 
Reset to default cfg (only on Level 2): reset to default values all the parameters, except gas fuel 
selection. It’s handy when you want to start from scratch again. 
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Resample map (only on Level 2): lets you change the references of a map. Please refer to the Maps 
and Tables chapter. 
 

2.1.3  ECU menu 
Firmware flasher: this feature is used to update the firmware of an ECU. Refer to the Firmware 
flasher chapter for details. 
 

 
ECU menu 

 
Switch to Compensated (only on Level 2): lets you toggle the ECU’s between Slave and Stand-
alone (Compensated) modes. When running in Stand-alone, the menu shows the Switch to Slave 
command. A dialog will ask you to confirm the operation; please refer to Slave and Stand-alone 
modes chapter. 
At the bottom of this menu you find a list of COM ports: any COM port found on your system is 
listed here. You need to select one only with Windows 98 or ME; on Win 2000, XP or Vista, the 
selection is automatic. 
 

2.1.4  Diagnostics menu 
Display meters: pops-up the Display window. It’s the same as the Display button in the tool bar. 
Details about the Display are in the last chapter. 
 

 
Diagnostics menu 

 
Error codes: shows a list of the Diagnostic Trouble Codes (DTC) generated by the gas ECU. You 
can access the list also clicking on Check engine, on the Status panel. Please refer to the 
Diagnostics chapter. 
Test mode (only for Level 2): it opens a window where you can check the injectors, solenoids and 
all the actuators of the gas system, while monitoring the sensor’s inputs. Please refer to the 
Diagnostics chapter. 
Disable gas solenoid (only for Level 2): disables temporarily the gas solenoids while running on 
gas, letting you test the petrol back-up features. Please refer to the Diagnostics chapter. 
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2.1.5  Help menu 
Pin out: pops up a window showing the ECU connector’s pin out, with pin descriptions and a 
picture of the ECU connector itself; when you select a pin on the list, a marker will blink on the 
picture, showing its position. 
 

 
ECU's pin out 

 
Supported DTCs: shows a list of the supported Diagnostic Trouble Codes of the gas ECU. You can 
browse the list and read the descriptions of all the implemented codes, that are reported in the Error 
codes list of the Diagnostics menu, whenever a fault is detected.  
 

 
List of supported DTCs 

 
About: recalls the splash window that is displayed when the program is launched. It is useful to read 
the software version and its serial number (S/N). 
 

2.2  Tool bar 

 
Tool bar of the main window 

 
Load: lets you select a configuration file (.cfg) from your hard-drive and download it into the 
ECU. It pops-up a file-open dialog where you can search for your configuration. 
 Save: saves the current configuration to a file. A file-save dialog will pop-up, where you can type 
the name of the file to save (or accept the default one), or even replace an old file. 
Undo: cancels the last operation. if you modify a parameter and you want to get back, Undo takes 
you back the last configuration before you changed that parameter.  
Display: it pops-up the Display window, displaying the acquired data in a graphical format. See 
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the last chapter to read more about it. 
Bank: every time you select the Gas map page on a 2 banked engine, this button appears at the 
right of the tool bar, letting you toggle between the first and the second bank. 
 

2.3  Status panel 
This panel at the bottom of the window shows the main data acquired from the ECU. It’s updated 
automatically every 100ms. 
 

 
Status panel 

 
The left-most box shows a fully working software change-over switch, identical to the one installed 
in the car. You can click its button to toggle between gas and petrol, or keep it pressed for 2 seconds 
to force an instant the transition to gas. The led level gauge on the top of it shows the currently 
measured level of gas inside the tank. 
 
Power: 

• Slave: the top-most label shows the mode of the ECU. If the ECU is set to Stand-alone, it 
will show Comp. 

• Check engine: it will blink in red every time the gas ECU finds a fault and genereate a 
Diagnostic Trouble Code (DTC). 

• RPM (Revs Per Minute): shows the current revs of the engine. 

• MAP (Manifold Air Pressure): shows the currently measured MAP in mbar. 
 
Injection:  

• Gas: shows the gas injection time computed by the ECU, in milliseconds. When working 
with 2 banks, you will see two boxes showing gas timings of cylinders 1 and 5. 

• Petrol: shows the petrol injection time measured from the petrol ECU, in milliseconds. 
There will be two boxes for two banks systems. 

 
Working point: 

• Gas: shows the temperature (in Celsius degrees) of the gas in the injection rail. 

• Water: shows the temperature of the water (in Celsius degrees) inside the pressure reducer. 

• Pressure: shows the gas pressure (in bar). Note that if the gas pressure is too low, this 
control blinks in red.  
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2.3.1  Lambda trace 
At the right hand side of the Status panel there is a chart showing the trace of the lambda signal: it 
plots the signals taken from the Lambda oxygen sensors, in real time. 
 

 
Lambda trace graph 

 
If you click the right-mouse button on it, a pop-up menu lets you choose which trace to plot: 

• Lambda 1 and Lambda 2: show the currently acquired signals from Lambda oxygen sensor 1 
and 2 (in Volts), if connected. The trace for lambda 1 is painted in solid green, while lambda 2 
is painted in solid light-blue. The Y axis of the graph is automatically scaled to the range of the 
selected lambda probe; please note that the trace for 5-0V reverse lambda probes is inverted, so 
when the trace stays up the lambda is rich, and when the trace gets down the lambda is lean. 

• Gas trim 1% and Gas trim 2%: while in Stand-alone mode, these show the percentage of the 
internal gas fuel trims. 0% is plotted in the middle of the chart, so these traces can show positive 
or negative values (from –50% up to 50%). The trace for bank 1 is painted in solid red, while 
the fuel trim for bank 2 is yellow. 

• Reference: shows the Lambda emulation reference voltage (in Volts), in dotted gray. 

• Emulate 1 and Emulate 2: show the emulated Lambda signals for bank 1 and 2, in Volts. The 
trace for bank 1 is painted in solid white, while the Emulated lambda 2 is painted in solid gray. 
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Chapter 3:  Wizard 
Each time you connect a brand new ECU, the Wizard comes up: this procedure guides you thru the 
steps of properly setting-up the ECU and create its maps for running on gas. 
You can also start the Wizard anytime you want, on any ECU, clicking the Wizard button on the 
General page, or selecting the Wizard item from the Edit menu. 
 

3.1  Starting the Wizard 
Once the Wizard is started, you will see its Welcome page and two buttons on the tool bar: 

• Next: allows you to go to the next step;  

• Abort: you can stop the Wizard anytime you want with this button. 
Initially the Next button might be disabled: before you can go on, the engine must be running and 
the water temperature higher than 50°C.  
 

 
Wizard welcome page 

 
The menus of the main window are available also in the Wizard: if you need to switch to Stand-
alone mode (only Level 2), please do so before going on. 
 

3.1.1  Auto-detection 
In the first step of the Wizard, the ECU is cleared and set to default parameters; anyway, the 
previous configuration is kept and restored whenever you abort the Wizard. 
 

 
Auto-detection in progress 
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The Wizard then goes into an auto-detection process: during this step it’s very important that you 
keep the engine on idle. It will automatically set a lot of parameters. 
 

3.1.2  Manual parameters 
The next step will show you the General page of the main window and instruct you to adjust the 
settings in it. 
 

 
Manual parameters in General page 

 

• Type in the Make and Model & Notes of the car; 

• Select the Aspiration (Naturally aspirated or Turbo) of the engine; 

• The ECU is preset to LPG; if you are using CNG, you need to change the Gas fuel. 
• Gas injectors are set by default to REG Fast; on Level 2, you can choose different ones, 

if you want.  

• You need then to select the Level gauge sender you have installed; 

• If the auto-detection was not able to adjust the RPM reading, the page will also show the 
Source of RPM signal and Pulses per rev parameters: you need to manually set those 
parameters to get the right RPM reading. 

 

3.1.3  Timings 
The next screen instructs you to rev up past 2500RPM and then release for three times: while you 
do that, the Wizard analyzes the signals from the engine and sets some more parameters. 
 

 
Timings page 
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Once the progress bar is completed, you can click the Next button and go on. 
 

3.2  Gas map tuning 
You are then ready to tune the gas map: the Tuning window appears over the gas map. 
 

 
Tuning high speed 

 
Before you can go on with the tuning, the water temperature must be higher than 70°C; on the 
top of the window, you get instructions in red.  

• Initially the Wizard computes a target speed and asks you to rev up to that speed. 
For a 4 cylinders cars, the target is 3000RPM. 

• The accepted speed range is shown as a green portion around the target speed, on the RPM 
meter: while in neutral or parking gear and all loads off (no A/C, no lights, etc), accelerate 
and try to move the needle into the green portion. 

• Click the Start button, when you’re ready; the procedure starts acquiring petrol timings and  

• When the lambdas start strobing (if connected), the “traffic light” on the left will turn from 
red light to yellow and then green; a blue progress bar will start moving. 
If there is no lambda connected, the progress bars starts immediately. 

• If RPM or injection timings are unstable, the progress bar may bounce back; keep the 
throttle pedal as much stable as possible. 
If it’s too difficult, you can click the Cancel button, change the target speed with the slider 
on the bottom of the window, and then start again. 

• Once the progress bar is complete, the system will switch to gas. It’s very important that you 
don’t move the throttle pedal, even if the engine revs up or down. 

• After some quick modifications to the gas map, the system will turn back to petrol and loop 
again. You can re-adjust the throttle pedal now, if needed. 

• After the procedure has acquired again the petrol timings, it will switch to gas again, to 
double-check the gas map; this time it will stay on gas longer. 

• The green portions on the petrol meters show the target timings: when the needles get close 
to the green portions, the gas map is almost ok. At the end, a big green box will inform you 
that the procedure ended successfully. 
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Note: the sensors are checked before and during the auto-tune. You might get these error messages: 

• wrong MAP reading: maybe the sensor is broken. You should check it. 

• Low gas pressure: the auto-tune will stop and warn you to check the shut-off valves. 
 

3.2.1  Tuning idle 
The tuning procedure will appear once more, this time for tuning the idle. The Wizard instructs you 
to let the engine idle and press the Start button. 
 

 
Tuning idle 

 
It’s exactly the same as the high speed tuning, but now you don’t need to touch the throttle pedal. 
Idle tuning is optional: the Next button on the tool bar will turn into Skip. If you click it and 
confirm, you will jump over this step and go on without completing it. 
Note: air conditioning, lights and all electric loads should be switched off, while tuning idle. 
 

3.3  Final report 
After tuning the idle, the wizard has finished and reports you the auto-detected parameters: 
 

 
Report window 

 
On the bottom, a green box with a progress bar will appear, while the new configuration is stored in 
the ECU. You can then click Ok; the ECU will be ready to run on gas. 
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Chapter 4:  Parameters 
A configuration is the set of parameters of the ECU and defines completely its behavior. They are 
organized in pages and the most important are in the first ones (General, Functions and Gas maps), 
while the last pages (Corrections and Drivability) are used only for fine-tuning. 
The pages themselves are divided into boxes, showing only a group of parameters; when you select 
a parameter (just click over it), its box glows in yellow, reminding you where you are. 
When you select a numeric parameter, after a second a blue label will pop-up below it, showing the 
range of accepted values. 
 

 
Blue range label, below selected parameter 

 
Note: remember to press ENTER on your keyboard, each time you change a parameter. It will be 
then downloaded to the ECU. 
 

4.1  General 

4.1.1  Engine 

 
Engine box of the General page 

 
Make: you can choose the car’s manufacturer from a list of common ones. Eventually you can type 
it manually. 
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Model & notes: you can type here the car’s model and some notes about the gas system, like 
nozzles size, or engine displacement, etc.  
Aspiration: lets you choose between Natural aspiration or Turbo. It recalls specific settings for 
N/A or turbo engines. A confirmation dialog will warn you that the gas map will be cleared, each 
time you change it. 
Lambda probe: this parameter is visible only if the Wizard is not able to set it. 

None: no lambda probe connected. • 
• 
• 
• 
• 

• 

• 

• 

0 – 1 Volt:  the probe’s voltage ranges from 0 to 1 Volt. This is the most common type. 
0 – 5 Volt: ranges from 0 to 5 Volts. 
5 – 0 Volt: ranges from 0 to 5 Volts, but the signal is inverted. Common on Range Rovers. 
0.8 – 1.6 Volt: ranges from 0.8 to 1.6 Volts. Very un-common. 

Source of RPM signal: this parameter is visible only if the Wizard is not able to set it. 
Wasted spark coil: the brown wire for reading the RPM is connected to a coil pack that’s 
feeding multiple spark plugs, like in old electronic ignitions and mechanical distributors. 
Direct coil: brown wire connected to a coil pack and there’s a coil on the top of each spark 
plug. Recent electronic ignitions are like this. 
Crank / Cam shaft: brown wire connected to the position sensor of the crank shaft (top 
dead center sensor), or to the phase sensor of a cam shaft, or to the tachometer. 

Pulses per rev: this parameter is visible only if the Wizard is not able to set it . Sets the number 
of pulses the ECU should get from the brown wire, per each rev. Can range from 1 to 255. 
Wizard: click this button to start the Wizard procedure and tune-up the ECU. Refer to the Wizard 
chapter for details. 
 
At the bottom of the box the Time on gas and Time on petrol counters show the hours and minutes 
the car has run on gas and on petrol. The counters are updated automatically as the car runs and it is 
not possible to clear them. 
 

4.1.2  Gas system 
 

 
Gas system box of the General page 

 
Gas fuel: lets you choose between CNG (Compressed Natural Gas) or LPG (Liquid Petroleum 
Gas) fuel. A confirmation dialog will appear if you change it, warning that the gas map is cleared 
each time you change gas type. 
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Gas injectors (only on Level 2): choose the type of the gas injectors installed in the system. The 
default is REG Fast. Other injectors type are supported, too. 
Number of banks (only in Stand-alone): set accordingly to the number of banks of the engine. 
 

4.1.3  Sensors 
 

 
Sensors box of the General page 

 
Gas gauge sender: sets the type of sender unit used to monitor the gas level in the tank. 

• 
• 
• 
• 
• 
• 

• 

• 
• 
• 

REG 1090 LPG: resistive sensor for LPG multi-valves; it ranges from 0 to 90 Ohm. 
REG 1050 LPG: reverse resistive sensor for LPG multi-valves; ranges from 5 to 0 Volts. 
REG 820 LPG: bigger resistive sensor for LPG multi-valves; ranges from 0 to 100 Ohm.  
REG 806 CNG: manometer for CNG; it’s reverse and ranges from 5 to 0 Volts. 
REG linear CNG: resistive sensor for CNG; ranges from 0 to 24 KOhm. 
Custom: this enables the Custom gas levels table, where you can set the threshold 
voltages as you like. 
Reverse custom: this is just like the Custom setting, but the voltages are reverse. 

TPS sensor range (only in Stand-alone): sets the type of TPS sensor, if connected. This 
parameter is automatically set by the Wizard; remember that TPS connection is not necessary in 
Slave. 

NONE: no TPS connected. 
0-5 Volt: standard type of TPS sensor. Also switch type are supported. 
5-0 Volt: reverse TPS sensor. 

Gas gauge threshold (only with Custom or Reverse custom gas gauge sender): this table lets 
you adjust the four thresholds that drive the gauge level display on the change-over switch. 
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4.2  Functions 
The ECU has the facility to automatically switch to gas for you after the engine has warmed-up 
running on petrol; the Gas yellow led on the change-over switch blinks when the auto-switch is 
enabled and the ECU is waiting for the engine to warm up. Once the warm-up conditions are met, 
the ECU switches to gas. 
The ECU supports also Start on gas and Mono-fuel features, where the auto-switch to gas is 
disabled and the engine starts on gas immediately. 
 

4.2.1  Gas power 
 

 
Gas power box of the Functions page 

 
 
Switch condition: lets you choose the condition for automatic switch to gas.  

• 

• 

• 

• 

• 

Acceleration: the ECU switches to gas when the revs of the engine are above a threshold 
(see below), thus when the car is accelerating. 
Deceleration: the ECU switches to gas when the revs get under the threshold, thus when 
decelerating. 
Cut-off: the ECU switches to gas when it detects a cut-off in the petrol injection, that 
usually happens when decelerating or shifting gears. 
Start on gas: the auto-switch to gas feature is disabled and the engine starts-up on gas (if 
the water temperature condition is met), thus petrol power is never used. The back-up to 
petrol features are available and also the gas priming time, at the bottom of this page. 
Mono-fuel: the auto-switch to gas feature is disabled and the engine starts-up on gas. The 
back-up to petrol features are defeated, thus petrol can not be used anymore. The gas 
priming time table at the bottom of this page is available. 

Delay: this is the initial, warm-up delay. When the engine starts, the ECU waits this time before 
evaluating the other conditions. Accepted values go from 0 to 765 sec, but it’s not available for 
Start on gas and Mono-fuel. 

Temperature: this condition inhibits the automatic switch, till the water is warm enough. 
Accepted values go from 0 to 100 °C. The parameter is not available for the Mono-fuel setting, but 
it’s active in Start on gas. 
Revs: sets the revs at which the ECU should switch to gas. Accepted values range from 500 to 
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4000 RPM, but it’s not available for Start on gas or Mono-fuel settings. 
Fill-up delay: when the warm-up conditions are met, the ECU powers the gas solenoid 
immediately, but waits some seconds before injecting gas. This let the gas fill up the rail and the 
pipes; after this delay, the gas injection starts. Use this delay to cure power loss during the switch; it 
can range from 0 to 5sec. 
Overlap time: after the gas injection has started, the petrol injection can be kept alive for few 
milliseconds, to achieve a smoother transition. You can set it up to 250ms. 
 

4.2.2  Start on gas prime time 
This table is visible only with Start on gas or Mono-fuel settings. It shows the injection timings 
that are applied when you start the engine: gas is injected before the engine starts cranking. 
 

 
Gas level box of the Functions page 

 
You can define up to six priming times for different temperatures: a red needle over the table shows 
the current water’s temperature. Both temperatures and injection times can be edited, copied and 
pasted: refer to the next Chapter about Maps and Tables to learn how to edit a table. 
The accepted injection timings range from 0 to 25.5 milliseconds; if you set it to 0, there will be no 
priming time. 
 

4.2.3  Back-up to petrol 
 

 
Back-up to petrol box of the Functions page 

 
At idle: activate this feature if you want to switch automatically to petrol anytime the engine gets 
back to idle. This can fix some idling issues while on gas. 

• 

• 

Revs: the ECU switches back to petrol when you rev down below this speed. Can range 
from 0 to 4000RPM. 
Duration: sets how long you want to stay on petrol, while on idle. By default it’s 3 sec; after 
that, it will switch to gas automatically. Accepted values range from 0 to 60sec. 
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Zero duration has a special meaning: the ECU won’t switch to gas and it will stay on petrol, 
till the usual automatic switch conditions are met. 

At full-throttle: this feature switches automatically to petrol when the engine reaches full throttle. 
This could cure power losses while on gas at extremely high engine loads. 

• 

• 

Revs: when the engine revs up above this limit and the Time condition is met too, the ECU 
switches back to petrol. Can range from 0 to 8000RPM. 
Time: when the injection timings are greater than this value and the Revs condition is met 
too, the ECU switches to petrol. The ECU returns to gas as soon as one condition is no 
longer satisfied. 

Note: by default both these features are disabled. If enabled, the leds on the change-over switch will 
not show that you’re on petrol. 
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Chapter 5:  Maps and tables 

5.1  Gas map 
Slave: the gas map shows the ratios between the gas injection times and the petrol injection times. 
The top-most row shows engine revs, while the left-most column shows the petrol injection time. 
The ratios can span from 0.00 to 1.99. Each bank has got its own gas map, in a two-banks engine.  
The ECU computes the gas injection times multiplying the petrol injection times (acquired from the 
petrol ECU) by those ratios, then adjusting the gas times with the corrections of the Corrections 
page. 
The cells are painted in blue (the higher the value, the lighter the color) and a red moving ball 
shows the engine's working point. 
 

 
Gas map 

 
Stand-alone (Compensated): the gas map shows directly the gas injection times (in milliseconds), 
that can range from 0.00 to 25.50 ms. The top-most row shows engine revs, while the left-most 
column shows the Manifold Air Pressure (MAP). Each bank has its own map. 
The ECU uses the times of the gas map directly as gas injection times; those times are then adjusted 
with the gas fuel trims and the corrections of the Corrections page.  
 

Note: if you press the SPACE bar on the gas map, you switch the fuel immediately. This is good to 
compare the injection timings between petrol and gas. 
 

5.1.1  Modify 
You can select a cell of a map clicking the left mouse button over it; you can also select a group of 
cells, dragging the mouse with the left button pressed. Selected cells are painted in dark blue. 
 

 
Selected cells in a map 
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To open the Modify dialog for the selected cells, you can: 

• Click the right mouse button 

• Press RETURN key 

• Type a number 

 
Modify dialog 

 

Set (CTRL+S): the value entered is put in all selected cell. 
Example: selected cells have 0.50, 0.75 and 1.00 values. If you type 1.20, all the cells will change to 1.20.  
Add (CTRL+A): the value entered (positive or negative) is summed to selected cell. 
Example: selected cells have 0.50, 0.75 and 1.00 values. If you type 0.20, the first value will change to 0.70, 
the second to 0.95 and the third to 1.20. 
Add % (CTRL+D): the selected cells are increased by the percentage you type; negative values 
decrease the selected cells. 
Example: lets take a cell with a 0.90 value. Adding a 10% would change its value to 0.99 (+10%).  
Bank (CTRL+B): lets you choose which bank to modify, in a 2 banks system. 

• The first time it shows the current bank number: the modification is applied only to the 
current bank. 

• If you click it once, it shows Bank 1+2: the modification is applied to both banks. 

• Click it once more and it switches the selected bank: the modification is applied to the new 
bank. 

 

To confirm the modification, press the RETURN key or click the Ok button; all selected cells are 
modified at once. To cancel the modification (and preserve the original values), press the ESC key or 
click the Cancel button.  
Please remember that all the changes are immediately downloaded into the ECU, so any 
modification to the maps is stored immediately in the ECU. 
 

5.1.2  Copy & Paste 
The Copy and Paste items of the Edit menu work with any map and table: simply select the cells 
you want to copy and choose the Copy menu item, or press CTRL+C on the keyboard. The selected 
cells are copied to the clipboard. Select then the cells you would like to replace and click on the 
Paste menu item (or press CTRL+V). 
The selected cells are copied to the Windows system clipboard, too, so you can copy data from the 
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program to another application (for example, a spread-sheet), but not vice-versa. 
 

 

Source: 3 rows x 4 cols Destination: 2 rows x 5 cols

Paste
 

 

Result: 2 rows x 4 cols copied

Copying some selected cells into another map 
 
Note: when working with two banks, if you copy and paste some cells of the gas map of one bank, 
the other bank is left unchanged: usually this is misleading, thus the program warns you that the 
other bank has not been changed. 
 

5.1.3  Resample 
The Resample map command of the Edit menu is available only in Level 2 and it’s enabled 
whenever you are on a map. 
 

 
Resample map window 

 
The resample feature lets you set different references for the map you are working on: for example, 
you can set new petrol injection timings and engine revs for the Slave gas maps. 
When you select the Resample map command in the Edit menu, the Resample map window pops up 
and lets you type in all the references for the rows and columns of the active map. Once you are 
finished, click on the Ok button and the map will be changed.  
This feature works differently than simply changing the references of the map, as you would do 
with the Modify dialog: resampling also changes the values inside the map.  
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5.2  Emulation 
The Emulation page is available only on Level 2 and it’s useful only to control the emissions of 
pollutants. There’s no benefit in drivability, using Emulation, so please use it only for emission 
tests. 
 

 
Emulation page 

 
The lambda reference table allow you adjust the gas mixture, thus reducing specific pollutants. Of 
course, the different pollutants are strongly linked together, so, for example, reducing NOx will also 
lead to an increase of CO and HC. 
When you work with a standard lambda probe (like 0-1V): 

• If you need to enrich the mixture, increase the reference voltage; 

• If you need to lean-out the mixture, reduce the reference voltage. 
Reverse lambda probes (like 5-0V) of course need opposite modifications. 
You can enable the emulation checking its check-box; the Lean and Rich levels are computed 
automatically during the Wizard and should not need any change. 
 
Note: lambda emulation feature needs that the original wire of the lambda probe is cut and both 
purple and gray wires of the gas harness are properly connected. If the wiring is not correct, the 
emulation won’t work. 
 

5.3  Corrections 
The Corrections page is available only at Level 2 and shows the water temperature correction table. 
The gas injection times are adjusted by correction percentages varying over water temperature: this 
allows to adjust the mixture also when the engine is cold. 
 The top row shows the reference water temperatures, while the bottom row shows the correction 
percentages. 
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Water's temperature table in Corrections page 

 
Accepted temperatures go from -20 to 235 °C, accepted percentages go from -100% to +100%. 
The Reset button clears the correction table to its default values; a dialog will ask confirmation. 
We do not reccomend that installers modify these settings. 
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Chapter 6:  Drivability page 

6.1  Acceleration control 
Use this feature to cure engine’s jerking during accelerations. 
 

 
Acceleration control box in Drivability page 

 
It works by temporarily enriching or leaning the mixture, whenever it detects an acceleration. You 
can set the percentage of correction with the slide-bar on the top: it ranges from -50% to 50 %. 
Negative values lean out the injection, while positive ones enrich it. A percentage of 0% won’t 
affect the injection and simply disables this feature. 
The bottom Acceleration slide-bar is available only on Level 2 and lets you adjust the sensitivity 
of the acceleration detection: 

• Slow: moving the slider to the left increases the sensitivity of the feature, so even lighter 
acceleration will fire the feature. 

• Hard: moving the slider to the right decreases the sensitivity, so only harder, stronger 
accelerations will fire the feature. Lighter accelerations are not affected. 

 
Please note that whenever this feature is fired, the box will glow in red. The feature needs a valid 
MAP reading to work. 

 

6.2  Injection control 
The features of this box help you curing jerking due to extra-injections, full-group injection strategy 
or transients.  

 
Injection control box in Drivability page 
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6.2.1  Extra-injection filter 
Petrol ECUs can generate spurious injection times while the engine is working at constant load, or 
even when pulling out of idle. Those extra-injections usually are shorter than 2 ms and are not in-
phase with the aspiration stroke; they can cause jerking while on gas. 
The Extra-injection filter is set automatically by the Wizard; anyway, it’s adjustable. 

• if you experience jerking when cruising at constant speed, chances are that you need to 
increase a little bit the filter setting; 

• if you experience strong shaking when pulling out of idle, maybe you need to increase the 
filter; 

• if instead the gas injection suddenly cuts-off, especially at very low loads, it’s time to 
decrease the filter. 

 
Note: extra-injection pulses can be easily detected by a sudden rising and falling of the ball on the 
Slave gas map.  
 

6.2.2  Full-group filter 
This setting is available only on Level 2. 
Petrol ECU’s injection strategy can be sequential, meaning that the fuel is injected in 1-3-4-2 
sequence (for a 4 cylinders engine), or it can be full-group: it means that the ECU injects fuel in all 
the cylinders at the same time. Other strategies are known, too, like the semi-sequential. You can 
check the injection strategy and sequence in the Injection sequence box. 
Usually the Dream XXI-P ECU can cope with petrol injection strategy; anyway, on smaller engines 
(especially older Peugeot) the gas injectors  can be annoyed by the very short petrol timings this 
injection strategy generates, most of all at idle. The filter is set automatically by the Wizard: 

• fully sequential engines: the filter is set to 5%; 

• semi-sequential or full-group engines: it’s set to 50%. 
Should you experience unstable idling with full-group engines, you can try to set the filter 
manually; usually, full-group injection is more problematic on lower loads and on idle. 
 

6.2.3  Smoothness 
This setting is available only on Level 2. This filter smooths out gas injection transients, making 
them slower: this some times helps curing jerking and generally improves drivability. 
If you are experiencing jerking during transients (most of all, accelerations) and the Acceleration 
control doesn’t fix them, try increasing the Smoothness slider; please note that setting higher than 
50-60% could affect idling. 

6.3  Injection sequence 
This box shows the injection strategy and sequence. 
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Injection sequence box in Drivability page 

 
It’s updated each time you open the Drivability page and its appearance depends on the petrol 
injection sequence detected: 

• Sequential: the box reports the gas injection sequence. Usually, on 4 cyl engine you will get 
ACDB sequence. If you see a gas injection sequence that’s not correct, it means that the 
petrol injectors cut-loom have been wired incorrectly. 
The Advance button lets you advance the gas injection sequence. 

• Semi-sequential: the box shows the groups of injectors that are fired together. Usually, on 4 
cyl semi-sequential engines you will see A-C, B-D groups. It tells you also how many times 
per rev the petrol injectors are fired. The Advance is not available. 

• Full-group: the box shows you only if the injectors are fired once or twice per engine rev. 
The Advance is not available. 

Please note that the injection sequence is influenced by the Extra-injection and Full-group filters. 
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Chapter 7:  Stand-alone mode 
The Dream XXI-P ECU can work in two completely different modes: the ECU comes set-up in 
Slave mode from the factory, but Level 2 users can activate the Stand-alone (Compensated) mode. 
While the Slave mode requires a Petrol ECU to get petrol injection times, in Stand-alone mode 
petrol fueling is completely ignored and the gas injection is determined by the gas ECU by its own. 
Note: Stand-alone is available only in Level 2. 
 

7.1  Requirements 
The Stand-alone mode has some more requirements than Slave mode: 

• Special wiring schemes for petrol-cut loom are required in case of single-point injection 
(Like Bosch Mono-Jetronic), mechanical injection (like Bosch Ke-Jetronic) or carburetor 
engines. 

• RPM: the brown wire of the gas harness must be connected (usually to an ignition coil), 
unless you are working on a fully sequential Electronic Fuel Injection engine. 

• MAP: the engine load is computed with the MAP reading. 

• TPS: when working with single-point injection, mechanical injection or carburetor engines, 
gas injection cut-off can be achieved only connecting to the TPS sensor (blue/yellow wire of 
the harness). 

• Lambda: the ECU uses its own gas fuel trims, so reading the lambda probe is mandatory. 

• Lambda emulation is needed only by Electronic Fuel Injection systems working in closed-
loop. Please note that emulation requires cutting the original wires of the lambda probes. 

 

7.1.1  Settings 
To switch to Stand-alone mode, open the ECU menu and select the Switch to Compensated item; a 
dialog will ask confirmation. Default settings will be loaded.  

 

 
ECU menu 

 
Basically you have the same parameters of the Slave mode and the Wizard works exactly the same,  
setting them up for you. Two more parameters are available in General page: 
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Parameters of General page in Stand-alone mode 

 
Number of banks: lets you set up the number of banks. The Wizard detects automatically the 
number of banks, but you can override its setting. 
TPS sensor range: choose which type of TPS system you have. The Wizard detects 
automatically this parameter, but you can override its setting. 
 

7.2  Closed-loop control 
In Stand-alone mode, the ECU implements a close-loop control of the gas injection by means of the 
gas fuel trims, one per each bank. The fuel trims are correction percentages applied to the gas 
injection times. 
Whenever a lambda probes is rich, its fuel trim gets lower and lower, reducing the injection times 
and thus leaning out the mixture, till the lambda goes lean. If instead the lambda is lean, the fuel 
trim gets higher and higher till the lambda goes rich.  

Closed-loop injection control 

RICH

LEAN

Increase
time

Decrease
time

Lambda 
voltage 

 

7.2.1  Gas trim 
The settings for the gas fuel trim are in the Fuel trim page of the main window.  
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Gas trim box of Fuel trim page 

 
The Gas trim it’s enabled by default, when in Stand-alone; do not disable it, otherwise you will 
have open-loop gas injection all the time. 
Lambda integrator: sets the strength of the fuel trims. The stronger the fuel trims, the bigger the 
corrections applied to the gas injection times, the quicker those times will change; so, when you 
move the fader to the Fast side, the fuel trims will be stronger and the gas times will change 
quicker. Move it to the Slow side, and the gas injection times will change more slowly. 
Balance: sets the mixture balance you want to achieve. When it’s zero, the fuel trims try to get 
stechiometric mixture. If instead you move it to the Rich side, the lambdas will stay a little bit 
longer in the rich part of the oscillation, thus leading to a slightly richer mixture; for older engines, 
it’s better to stay a little bit richer. 
Lambda strobing period: the two faders let you set the period of oscillation of the lambdas at 
Idle and at 6000RPM; in-between, the period will be interpolated. 
For example, if idling is unstable with oscillating engine speed, you should increase the idle lambda 
period, till the speed oscillation disappears. 
 
On the bottom of the page you can see the fuel trim percentages for each bank: the parameters for 
the two fuel trims are the same, but they are using two separate lambda probes, so their values can 
be different. 
These gas trims are short-term fuel trims that affect the gas injection times only temporarily. A 
long-term fuel trim is implemented, too, by means of the gas map adaptivity: the gas maps will be 
modified according to the average values of the fuel trims, so the maps will be automatically 
adjusted to have the fuel trims as close to zero as possible. 
 

7.2.2  Open loop 
This feature defeats the fuel trims at high load conditions. It helps getting more power during 
accelerations: the fuel trims are temporarily disabled and the gas injection goes in open-loop, taking 
the timings directly from the gas maps. 
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Open loop box of Fuel trim page 

 
MAP and Revs: when the MAP is higher than this pressure and the engine revs above this speed, 
the fuel trims are defeated. Whenever one of the two condition ceases, the fuel-trims start working 
again. 
Delay: once the MAP and Revs conditions are met, the ECU waits this time, before defeating the 
fuel trims. This avoid switching the fuel trims off during short transients. 
 
Note: the mixture during open-loop is determined only by the values in the gas maps. Check that 
it’s rich enough, otherwise you could damage the engine or the cat. 
 

7.3  TPS cut-off 
In Drivability page there is one more feature, while in Stand-alone: 
 

 
TPS cut-off box in Drivability page 

 
When working with a petrol ECU, whenever the petrol injection cuts-off, also the gas injection is 
cut. If instead you are not working with an EFI system, you can achieve cut off when the TPS 
voltage goes below a threshold: 
Fall time: set the time it takes to go from injection to cut-off 
Revs: below this speed, there will be no cut-off. By default, as soon as the engine revs below 
1500RPM, the gas injection starts again; this is how the system gets back to idle. 
TPS: it’s the threshold below which you want cut-off. As soon as the TPS goes above the 
threshold, injection starts again. 
With 5-0V TPS systems, the cut-off feature is engaged when their voltage rises above the threshold. 
Tolerance: lets you set a voltage range to cope with noise in the TPS line. The 0.30V default 
setting should be fine for most engines.
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Chapter 8:  Firmware flasher 
The firmware is the core software that’s inside the ECU and handles all its tasks; with the Firmware 
flasher, you can upgrade an old ECU writing a new firmware into its memory. 
 

8.1  Upgrade the firmware 
Anytime you need to upgrade an ECU, select the Firmware flasher item of the ECU menu; it will 
guide you through an automatic procedure. 
 

 
Firmware flasher window 

 

8.1.1  Requirements 
• The ECU must be powered, that is the engine’s key must be in the On position (it’s a good 

idea to leave the engine running). 

• Connections of the USB interface: the ECU should be communicating with the software. 
The procedure automatically goes thru a sequence of steps and the instructions are clearly printed in 
red on the top of the page.  
Emergency: if for some reason the ECU does not respond to the flasher, an ‘emergency’ procedure 
will start asking you to manually switch the ECU off and then power it up again: the flashing 
process then goes on normally.  
 

8.1.2  File selection 
When the initial steps are completed, the procedure asks you to choose a file from the Firmwares 
folder: it will be written to the ECU’s memory. 
The procedure checks the file’s content and warns you if the file is not valid; in that case the ECU 
won’t be upgraded and you should pick another file.  Please use only the approved firmware files 
you find in the Firmwares folder: they were copied during the software installation procedure. 
You can select the firmware using a standard file-open dialog; the file names report the firmware’s 
tag and release date. Once you’ve selected a valid file, the program asks you confirmation to start 
flashing the ECU’s memory. 
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8.1.3  Flashing new firmware 
While the flashing procedure is writing the ECU’s memory, a progress bar shows you the 
percentage of completion. It should take a couple of minutes to completely write a new firmware on 
the ECU. 
 

 
Firmware flasher in progress 

 
IMPORTANT: the procedure should never be stopped while flashing the ECU. If the PC is 
accidentally powered off during firmware flashing, the firmware may not be flashed completely, so 
the ECU maybe will not work. In that case, simply re-flash the firmware again: this time, the 
emergency procedure will ask you turn the ECU off and then on again. 
 
Once finished, an ‘Upgrade successful’ message will appear. The previous configuration is 
automatically restored and the flasher window is closed: now your ECU is successfully upgraded 
and ready to use. 
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Chapter 9:  Diagnostics 
The Dream XXI-P ECU is eOBD-compliant and implements complete diagnostic features; it 
complies to the KWP-2000 protocol (ISO 14230) and performs diagnostic checks on all the inputs 
and actuators. These features are controlled by the commands in the Diagnostics menu. 
  

9.1  DTC error codes 
The ECU performs diagnostic checks whenever it is powered; if an error condition is detected, a 
Diagnostic Trouble Code (DTC) is generated. You can reach the list of generated DTCs selecting 
the Error codes (DTC) item in the Diagnostics menu. 
 

 
Diagnostic Trouble Codes 

 
Click the Update button to refresh the error codes. If you wish to save the codes, you can click the 
Save button and choose a name for the plain text file that’s going to be saved. 
The Clear button clears the codes: a dialog will ask confirmation. Once cleared, the old codes are 
lost, but if an error condition is still present, a new DTC will be generated immediately. 
Each line in the list has got its own code (like P3124) and description; please refer to Appendix A 
for a list of supported error codes. 
At the left of each code you can read the status of that specific error: 

• Present: the error condition is still present. You can clear the code, but the error condition will 
generate the same DTC again immediately.  

• Stored: any error condition detected in previous driving cycles but no more present in current 
driving cycle, becomes Stored.  

• Not ready: any stored error code which the ECU is not ready to check again, is declared as Not 
ready. As soon as the working conditions become appropriate (switching to gas, for example), 
the DTC changes into Stored or Present. 
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9.1.1  Freeze-frame data 
When a DTC is generated, the system’s working point is saved into a ‘freeze-frame’: it is a sort of 
snap-shot of the conditions that generated the last error. You can have a look at those data selecting 
the Freeze-frame page of the Diagnostic Trouble Codes window. 
 

 
Freeze-frame data 

 
The freeze-frame is made of: 

• Error code: the DTC that the freeze-frame refers to. Only the code is reported. 

• Engine’s rev, water temperature, gas temperature, gas pressure, MAP, lambda 1 and 2 voltages, 
gas fuel trims 1 and 2 (only for Stand-alone mode), petrol injection timings for bank 1 and 2, 
gas injection timings for bank 1 and 2 and gas level in the tank: all this data shows the working 
point of the engine.  

• Status: this shows the status of the engine when the error was detected. It can be: key-voltage 
on, waiting, engine on, engine off or stall.  

• Power mode: working status of the ECU. It can be: running on petrol, on gas, waiting to switch 
to gas, running on petrol because of a back-up condition, etc. 

• System time: this shows the system internal time (in seconds) when the DTC was generated. 
Note: the system time is not cleared at the engine start. 

• Fuel: it can be petrol or gas. 
You can click the Update or the Clear buttons to refresh the freeze-frame. You can also save the 
freeze-frame into a plain text-file just clicking the Save button. 
Please note that the freeze-frame refers only to the last DTC. 
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9.1.2  Supported DTCs 
The Supported DTCs item of the Help menu shows you the list of all supported error codes with 
their descriptions. Please refer to Appendix A for the list of supported DTCs. 
 

 
List of supported error codes 

 
 

9.2  Test mode 
The test mode checks the actuators and inputs of the gas ECU; it’s available only at Level 2. To 
start it, select the Test mode command in the Diagnostics menu; a message will warn that the tests 
should be performed only in controlled conditions. It’s not advisable to do them on the road. 
The ECU is on petrol for all the time the test mode is on; the normal operations are interrupted, so 
you can’t switch to gas nor edit the configuration, till you exit the test mode.  
 

 
Test mode 

 
You can stop the test mode at any time closing its window: a dialog will ask confirmation, then the 
ECU resets and few seconds later it returns to normal operation. 
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9.2.1  Outputs 
While the test mode is on, you can test the actuators of the gas system: 

• Gas solenoid: click the switch to power the gas solenoid. To power it down, turn off the 
switch. When the solenoid is powered, the gas fills the injection rail. This test is harmless. 

• Gas injectors: you can activate the injectors one by one, toggling their switches. If there is 
gas in the rail, a small amount will flow into engine, thus disturbing the petrol injection. 
If the gas solenoid is powered when you power an injector, a steady flow of gas will be fed into 
the engine, disturbing even more. 
The software doesn’t allow to switch on more than two injectors at a time and no more than 2 
seconds.  

• Petrol injectors cut: you can test the petrol injectors cut circuit. When you activate it, the 
petrol injectors will be disabled and the fuel injection will cut-off. The engine will certainly 
stall. 

• Emulation relay: activate this switch to check the emulated lambda voltages. Do not activate 
this relay when the engine is running and the gray or gray/black wires of the gas harness are 
connected to the OEM ECU. 

• Emulated lambda 1 and 2 voltage: use these faders to change the voltages applied to the 
gray and gray/black wires of the harness. You have to enable the emulation relay, before you 
can measure any voltage in the wires. 
It’s not advisable to perform these tests with the engine on.  

• Test switch: you can select the desired setting for the change-over switch and check its leds 
and buzzer. This test is harmless. 
 

9.2.2  Inputs 
• Switch pressed: whenever the button of the change-over switch is pressed, the green light 

turns on. 

• RPM signal active and Period: the green light will flash any time the ECU detects a pulse 
on the brown wire. The Period box shows the time between two pulses, in seconds. 

• Petrol injectors: the leds will blink each time the ECU detects a petrol injection. 
The refresh frequency is low, so it’s perfectly normal if some led stays on or off for few 
seconds. 

• Analog input: lets you check the voltages of the analog inputs of the ECU. The values are 
measured at the inputs of the ECU and may not be the actual voltages. You can measure: 

- Voltages of the lambda oxygen sensors, bank 1 or 2 
- Battery voltage 
- 5V sensors power 
- Voltages of MAP and rail pressure sensor 
- Voltage of the gas level sender 
- Voltage of rail temperature sensor 
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- Voltage of water temperature sensor 
- TPS voltage 
- Voltages of the shunt resistors inside the ECU that measure the current of each gas 

injector. 
 

9.3  Disable gas solenoid 
The last command of the Diagnostics menu lets you disable temporarily the gas solenoid; this 
command is available only at Level 2. Differently from the solenoid switch in Test mode, you can 
use this command during normal operations; it’s also tied to the F12 key on the keyboard. 
 

 
Diagnostics menu 

 
You can use this command while on gas to test the low level or the low pressure back-up features: 
simply rev up the engine, select the command from the Diagnostics menu (or press the F12 key) 
and confirm the operation.  
A green label will confirm you that the gas solenoid is disabled: 

• The gas flow is now inhibited and thus the gas pressure start dropping down; 

• Because of the lack of fuel, the engine will rev down and eventually stall; 

• When the pressure reaches the low-pressure threshold, the ECU should fire the low pressure 
back-up and switch to petrol before the engine stalls. 

You can re-enable the gas solenoid un-checking the command in the Diagnostics menu, or pressing 
the F12 key again. 
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Chapter 10:  Display window 
The Display window is shown when you click the Display button in the tool bar of the main 
window or select the Display meters menu-item of the Diagnostics menu. 
 

 
Display window 

 
While the ECU is connected and powered-up, all the graphical meters show the currently acquired 
data from the ECU as they change in real-time. 
 

10.1  Chart 
The Chart can show a window of 100 seconds of measured signals. It automatically scrolls to the 
left while the acquisitions go on.  
You can have a full screen look at the Chart if you double-click the left-mouse button: the Chart 
will enlarge and hide completely the Engine box, leaving only the Injectors visible. To reset the 
Chart to its original size simply double-click on it once more. 
 

 
Chart in full screen 
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10.1.1  Traces 
You can choose what you want see with the legend at the left: it lists all available traces. To see a 
trace on the Chart, check-mark its box; un-check to hide it. The color of a box is the same used to 
plot the trace on the Chart.  

 
Legend of the Chart 

 
The traces are drawn in the Chart as percentages of their maximum value: the Y-axis of the Chart 
shows percentages from 0 to 100%. You can scale the traces modifying their max value in the 
legend. The available traces are: 

• RPM: this is the engine’s speed in RPM. 

• MAP: the MAP signal, in bar. 

• TPS: the TPS voltage in Volt. 

• Gas A, B, C, D, E, F, G, H : the gas injection time for each cylinder, in ms. 

• Petrol 1, 2, 3, 4, 5, 6, 7, 8: the petrol injection time for each cylinder, in ms. 

• Lambda 1, 2: the lambda probes voltages in Volt, if any. 

• Reference: the lambda reference in Volt, as reported in the reference tables of the Emulation 
page in the main window. 

• Gas trim 1, 2: the percentage of gas fuel trims for Stand-alone mode. 

• Emulated 1, 2: the emulated lambdas voltages in Volt. 

• Gas °C: the temperature of the gas in the injection rail. 

• Water °C: the temperature of the water inside the pressure reducer. 

• Press: the differential gas pressure in mbar. 

• Gas level: the voltage of the gas level sender, in Volt. 

• Battery: the voltage of the battery of the car. 

• Vcc: the 5V power line of the ECU, that feeds the sensors. 
 

10.1.2  Save 
The Save button on the bottom of the legend lets you save the data acquired to your hard-drive: 
click it once and it will open a file-save dialog, to choose the file where you want to save the data. 
The program then writes all the data into the chosen file: every signal acquired from the ECU is 
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saved, not only the traces you’ve selected on the chart. When you open the saved file back, you can 
see all the available data. 
 

 
Saving data 

 
While saving data, the background of the Chart is painted in red, to remind you that you are saving 
to disk. 
To stop saving, click again the Save button or close the Display window: a dialog will pop-up 
asking confirmation. 
Note: data is stored in text files (.txt files) and the fields within are separated with TAB characters; 
you can import those files in any spread-sheet software. 
 

10.1.3  Load 
You can look at the data saved in a file just clicking the Load button: a file-open dialog will pop-up 
asking you to choose a file. 
 

 
Data loaded from an acquisition file 

 
The chart’s background will be painted in green, reminding that you are watching to saved data and 
not the real-time acquisitions as usual: of course, while watching at a file, the live signals acquired 
from the ECU are not traced.  
Once the file is opened, the chart expands to show all the acquired data. 

• You can select whatever trace you want from the Legend (remember that every trace is 
saved).  

• You can scale the traces modifying their max value in the Legend. 

• You can even zoom-in, simply drawing a rectangle from left to right, top to bottom with the 
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left-mouse button. 

• You can also scroll the chart, dragging the right-mouse button over it. Only scrolling left or 
right is allowed. 

• To zoom-out and reset the Chart, simply draw a right-to-left or bottom-to-top rectangle with 
the left-mouse button. 

When you’re finished, click again the Load button and the chart returns to work in the usual way; 
the background is painted in blue and the real-time data appear on it. 
 

10.2  Needle meters 
This box is in the center of the Display window and shows the current engine’s working point. 
 

 
Needle meters 

 
From left to right, you can see: 

• Engine speed, in RPM, up to 8000 RPM; 

• MAP pressure in mbar; 

• Gas differential pressure, in mbar. The yellow portion shows lower pressures.  

• Battery voltage, in Volt; 

• Gas temperature in °C; 

• Water temperature in °C; 

• Lambda 1 voltage, on the bottom; 

• Lambda 2 voltage, on the bottom; 

• Gas level percentage in tank, on the bottom. 
 

10.3  Injectors 
At the bottom of the Display window there is the Injectors box: it shows the gas and petrol injection 
times for all the supported cylinders. 
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Injectors box 

 
The top-most meters show the gas injection times for each cylinder, while the bottom ones show 
petrol. Only the injectors that are detected are lighted: the un-connected injectors are grayed out. 
This is helpful when checking the wirings. 
 Please note that for two banked systems the injectors are split in two groups: 1, 2, 3 and 4 belong to 
bank 1 (along with gas injectors A, B, C and D), while 5, 6, 7 and 8 belong to bank 2 (with gas 
injectors E, F, G, H). 
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Chapter 11:  Appendix A 

11.1  List of supported Diagnostic Trouble Codes (DTC) 
- P3391: Sensor power circuit range/performance 
- P3394: Sensor power intermittent 
- P3121: Gas temperature sensor - Too Low temperature 
- P3122: Gas temperature sensor - Too high temperature 
- P3124: Gas temperature sensor - Short circuit to plus 
- P3125: Gas temperature sensor- Short circuit to ground 
- P3126: Gas Temperature Sensor - Circuit Intermittent 
- P3131: Water temperature sensor - Too Low temperature 
- P3132: Water temperature sensor - Too high temperature 
- P3134: Water temperature sensor - Short circuit to plus 
- P3135: Water temperature sensor - Short circuit to ground 
- P3136: Water Temperature Sensor - Circuit Intermittent 
- P3110: Gas pressure sensor – Too low pressure 
- P3111: Gas pressure sensor – Too high pressure 
- P3112: Gas pressure sensor – Cut wire 
- P3113: Gas pressure sensor – Short circuit to plus 
- P3114: Gas pressure sensor – Circuit intermittent 
- P3220: No injector 1 command detected from petrol ECU 
- P3221: No injector 2 command detected from petrol ECU 
- P3222: No injector 3 command detected from petrol ECU 
- P3223: No injector 4 command detected from petrol ECU 
- P3224: No injector 5 command detected from petrol ECU 
- P3225: No injector 6 command detected from petrol ECU 
- P3226: No injector 7 command detected from petrol ECU 
- P3227: No injector 8 command detected from petrol ECU 
- U3000: Link wire between injector 1 and gas ECU – Short circuit to GND or cut wire 
- U3002: Link wire between injector 2 and gas ECU – Short circuit to GND or cut wire 
- U3004: Link wire between injector 3 and gas ECU – Short circuit to GND or cut wire 
- U3006: Link wire between injector 4 and gas ECU – Short circuit to GND or cut wire 
- U3008: Link wire between injector 5 and gas ECU – Short circuit to GND or cut wire 
- U300A: Link wire between injector 6 and gas ECU – Short circuit to GND or cut wire 
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- U300C: Link wire between injector 7 and gas ECU – Short circuit to GND or cut wire 
- U300E: Link wire between injector 8 and gas ECU – Short circuit to GND or cut wire 
- P3200: Gas injector A cut wire 
- P3202: Gas injector B cut wire 
- P3204: Gas injector C cut wire 
- P3206: Gas injector D cut wire 
- P3208: Gas injector E cut wire 
- P320A: Gas injector F cut wire 
- P320C: Gas injector G cut wire 
- P320E: Gas injector H cut wire 
- P3230: Oxygen sensor 1 – Short circuit to GND 
- P3231: Oxygen sensor 1 – Short circuit to plus 
- P3233: Oxygen sensor 2 – Short circuit to GND 
- P3234: Oxygen sensor 2 – Short circuit to plus 
- C2000: Switch button - Short to GND 
- P3160: Absolute gas pressure sensor - Short circuit to GND or cut wire 
- P3161: Absolute gas pressure sensor - Short circuit to plus 
- P3170: Absolute MAP sensor - Short circuit to ground or cut wire 

- P3171: Absolute MAP sensor - Short circuit to plus or cut wire 
- P3140: Gas level sensor - Short circuit to plus or cut wire 
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